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1 Introduction

AADL Inspector is an analysis framework for source texts complying with the standard
definition of the Architecture Analysis and Design Language (AADL). The formal
definition of the AADL language can be found in the SAE AS-5506B document and
general information about this language is available on the AADL committee web site:
www.aadl.info.

AADL Inspector is packaged in a light weight standalone distribution that minimizes
installation and maintenance effort in order to ease the every day use of the product on
standard personal computers or network servers. The product is available for both
Windows and Linux platforms.

The goal of AADL Inspector is to encompass a variety of tools to process a complete
AADL specification composed of a set of text files. These files can be created within
AADL Inspector itself, loaded from pre-existing local or remote libraries or
automatically generated by an import wizard. AADL files can also be organized into
projects to facilitate the management of large models. The processing tools can be used
to analyse various facets of the architecture or to offer code and documentation
capabilities. These processing tools are organized in a modular and extendable way so
that additional tools can easily be included.

The standard installation of AADL Inspector 1.3 includes the following processing
tools:

- AADL syntactic analysis

- instance model overview and declarative model statistics (Metrics)

- architectural (static) semantics (Naming, Legality, Consistency and ARINC653)
- real-time (dynamic) semantics (Cheddar and Marzhin)

It is also possible to modify the current AADL specification either with a direct edition
of the opened source text files, or by using a set of wizards that enable advanced
functions such as:

- select the root of the system instance hierarchy

- set the thread priorities according to the given scheduling protocol (RM, DM)
- bind threads to available processors with allocation algorithms
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- modify the main thread real-time properties in a spreadsheet
- apply uniform text formatting rules (autoformat)

- convert older versions of source text into AADL v2.1

- import OMG UML MARTE models into AADL

The current version of AADL Inspector covers the following standard definitions:

- AADL Core (v1.0, v2.0 and v2.1)

- AADL Behaviour Annex (v1.0 and errata)

- AADL Error Model Annex (v1.0 and 2.0 draft 0.97)
- AADL Data Model Annex

- AADL ARINC 653 Annex
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2 Before starting

2.1 Installation

Installation of the product only requires the following easy actions:

- get a copy of the installation package for the desired platform (Windows or
Linux) from the Ellidiss download site: http://www.ellidiss.com/downloads.asp

- run the installation program on Windows or uncompress and expand the archive
file on Linux.

- launch the AADLInspector executable file located in the appropriate bin
subdirectory of the installation directory, or the corresponding desktop shortcut
on Windows.

Downloaded packages usually come with a temporary trial license that can be used free
of charge. If you purchased the product or this temporary license has expired, please
contact Ellidiss customer support service to get the appropriate license information and
installation procedure that fits your situation. A standard installation requires less than 40
Mbytes of free disk space.

Currently, only the 32bits versions of the executable files are provided. Before running
the product on 64bits platforms, please check that the 32bits compatibility package is
installed (i.e. 1a32-1ibs on Linux)

2.2  Distribution contents

After having properly been installed on the computer, the AADL Inspector installation
directory contains the following subdirectories:

- bin.w32 orbin. 132 subdirectory
- Dbin.common subdirectory

- config subdirectory

- examples subdirectory

- doc subdirectory
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bin.w32 contains platform dependent executable files for Windows, whereas
bin.132 contains the corresponding files for Linux platforms.

bin.common contains . jar files that are common to all platforms.

In addition, after a first launch of the tool, a directory is created to store temporary files.
The actual location of this temporary directory can be customized by the 1ogbirectory
parameter in the config/AIConfig.ini file, or the -1 command line option.
Default location of the temporary directory is within the user’s home directory.

2.2.1. Bin subdirectories

These directories contain the executable files for the current platform or Java archive
files that are shared by all platforms. The only external requirement is the availability of
a proper Java Run-time Environment (JRE) that is only needed to run the simulator.
These files are:

- AADLInspector main executable file

- AIMonitor remote process monitoring executable file

- aadlrev executable file (AADL syntactic analyser)

- xmlrev executable file (XML syntactic analyser)

- sbprolog executable file (Prolog engine)

- cheddarkernel executable file (Cheddar schedulability analyser)

- Marzhin, VAgent and VCore Java archive files for the Marzhin simulator

aadlrev 2.5 is a standalone AADL syntactic analyser that is used by the LMP (Logic
Model Process) technology to convert AADL specifications into list of Prolog
predicates. This utility tool can analyse textual AADL files that comply with AADL 2.1
(SAE AS-5506B) , the AADL Error Model vl (SAE AS-5506/1 Annex E), the AADL
Behaviour Annex (SAE AS-5506/2 Annex D), and the AADL ARINC 653 Annex (SAE
AS-5506/2 Annex F). In addition, the draft 0.97 of the new AADL Error Model v2 (future
SAE AS-5506/3 Annex E) is also supported by aadlrev. Most of the AADL 1.0 (SAE
AS-5506) and 2.0 (SAE AS-5506A4) syntax is also recognized and can be automatically
converted into the newest 2.1 format. More information about AADL can be found at:
http://www.aadl.info
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xmlrev 1.0 is a standalone XML syntactic analyser that is used by the LMP (Logic
Model Process) technology to convert XML or XMI serialized models into list of Prolog
predicates.

cheddarkernel 3.0 is a command-line version of the Cheddar v3 schedulability
analysis tool. Cheddar v3 models (.xmlv3) are generated from the AADL
specification thanks to a dedicated LMP model transformation. Cheddar outputs
(feasibility tests reports and static chronograms) are displayed in the AADL Inspector
graphical interface. Cheddar is an open source project managed by the University of
Brest: http://beru.univ-brest.fr/~singhoff/cheddar

sbprolog 2.5 is an open source Prolog engine that is used by the LMP (Logic Model
Processing) technology. AADL Inspector uses LMP to implement the various AADL
rules checkers and model transformations. SB-Prolog was developed by State University
of New York at Stony Brook and the University of Arizona.

marzhin 2.0 is a multi-agents simulator implementing the AADL run-time. It consists
of three Java archive files and requires a Java Run-time Environment (JRE) to operate.
No JRE is provided with the AADL Inspector distribution. Marzhin v2 models (. xml)
are generated from the AADL specification thanks to a dedicated LMP model
transformation. Marzhin outputs (dynamic chronograms) are displayed in the AADL
Inspector graphical interface. Marzhin is developed in collaboration by Virtualys and
Ellidiss Technologies.

2.2.2. Config subdirectory

This directory contains initialization and configuration files that are used by the
executable files.

The files having a .sbp extension contain a binary form of the LMP (Logic Model
Processing) rules that are used to perform each analysis action. Checkers provide a direct
textual report into the AADL Inspector window, whereas adaptors perform dedicated
model transformations to interface with ancillary tools such as Cheddar and Marzhin.
More rules files will be added in the future and it is also possible to include corporate or
project specific checking or adaptor tools in simply adding a rule file into this directory
(“plug and check” feature). Please contact Ellidiss Technology (aadl@ellidiss.fr) to use
this advanced feature.
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The files having a .ais extension contain a description of each AADL Inspector
processing tool or wizard. Each processing tool or wizard provides one or several
services that will be available via menu options or buttons. Each service is described by a
sequence of elementary commands. Note that the .aip plugin description files that
where available with the previous versions of AADL Inspector are no more usable.

The AIConfig.ini file contains the declaration of three sets of user variables: config,
plugins, gantt, accelerators and license. These options are not supposed to be changed by
the end user without an explicit recommendation from the technical support.

With the standard distribution, the config directory contains the following additional
sub-directories and files:

2.2.2.1.  Common plugins

These plugins can be removed and customized. New plugins can also be added there.
They are not platform dependent. They are located in the plugins.common
subdirectory.

AADL Static Analysis:
- AadlAnalysis.ais: tool description file
- metrics.sbp: AADL metrics checker
- naming.sbp: AADL naming rules checker
- legality.sbp: AADL legality rules checker
- consistency.sbp: AADL consistency rules checker
- arinc653. sbp: preliminary version of the ARINC 653 rules checker

Schedulability Analysis:
- Cheddar.ais: tool description file
- schedulability.sbp: AADL to Cheddar model transformation

Simulation:
- chronogram. sbp: chronograms configuration rules
- marzhin.sbp: AADL transformation rules for Marzhin
- Marzhin.xml,MarzhinLogs.xml: simulation configuration files
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Wizards:

aadlgen.sbp : AADL generator (unparser)
readRTProperties. sbp : AADL real-time properties reader
writeRTProperties.sbp : AADL real-time properties writer
rootselector.sbp: AADL instance model configuration rules
Marte.ais: wizard description file

marte.sbp: UML MARTE to AADL transformation rules

2.2.2.2.  Platform dependent plugins

The subdirectories plugins.w32 and plugins.132 are not currently used. Their
role is to give the ability to call platform dependent commands during the execution of a
service provided by a processing tool or wizard.

2.2.3. Examples subdirectory

This directory contains a few AADL examples to practice the use of AADL Inspector.
Two kinds of files are proposed: individual AADL source files (.aadl) or AADL
Inspector project files (.aic) that provide a list of individual AADL source file
pathname or URL. It is recommended to load a project file instead of individual AADL
files, in order to open all the required AADL packages and Property Sets that are
required to activate the analysis tools.

dataflow.aic: basic set of three periodic tasks

messages.aic: use of queued events

shared data.aic: use of Priority_Ceiling Protocol

client server.aic: use of remote subprogram calls

timed.aic: use of Timed dispatch protocol

hybrid.aic: use of Hybrid dispatch protocol

display system.aic: large model

mars_ pathfinder.aic: show priority inversion problem
satellite.aic: use remote access to the AADLib github (requires internet

access)
ARINC653 directory: three variants of a simple partitioned system
Common directory : a few predefined AADL Property Sets and libraries
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2.2.4. Doc subdirectory

This directory contains a list of .pdf files (including this manual) that can be opened
from the help menu of the graphical user interface.

2.2.5. Command line options

AADL Inspector can be launched from a command line. The following optional
parameters are available:

- -a filel.aadl, file2.aadl, ..
open the specified AADL files
- -r dirl, dir2,..
open all the AADL files contained in the specified directories
- -p projectl.aic, project2.aic,..
open all the AADL projects contained in the specified directories.
- -1 logdirname
use the specified location to create the temporary files. If used, this information
overrides the one specified by the logDirectory parameter in the
AIConfig.ini file.
- --plugin tool.service
start a service of a tool as defined in a . ais file of the config directory.
- --result file
store the result file in the specified file
- -—--result stdout
only for Unix systems. Display the plugin result in the console.
- --show false
launch AADL Inspector without showing the graphical interface.

A particular case where AADL Inspector is launched in command line mode is its
integrated use with the Stood AADL graphical modelling tool. With recent versions of
Stood (Stood 5.3 or more recent), AADL Inspector is automatically called after the
generation of textual AADL code has been completed. The list of AADL files that are
loaded are all those related to the Stood project, 1.e. the current design as well as the
various libraries.

Another example of use of the command line activation of AADL Inspector is to run
Cheddar on a set of specified AADL files and get the results in a specified output file:
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bin.132/AADLInspector
-p examples/dataflow.aic
--plugin Schedulability.cheddarTheoTest
--result dataflow.xml
--show false

Such a command will create a file containing the result below (fragment). The detailed
description of the Cheddar output is provided in a separate annex document.

<results>
<feasibilityTest name="processor utilization factor" .>
<computation name="base period" reference="all" value="300" ../>

<computation name="processor utilization factor with deadline"
reference="all" value="0.78333" ../>

<computation name="processor utilization factor with period"
reference="all" value="0.78333" ../>

</feasibilityTest>
<feasibilityTest name="worst case task response time" .>
<computation name="response time"
reference="root.my platform.CPU.my process.Tl" value="15" ../>
<computation name="response time"
reference="root.my platform.CPU.my process.T2" value="10" ../>
<computation name="response time"
reference="root.my platform.CPU.my process.T3" value="5" ../>
</feasibilityTest>
</results>

2.3 License

A valid license is required to use AADL Inspector. Various kind of licenses are
available, including free of charge evaluation and education licenses. Payment of a
license fee is required for commercial or industrial usage of AADL Inspector. Please
contact your Ellidiss sales representative for more details.

License information is stored in the ATConfig.ini file. Licenses can be attached to a
particular computer and limited in time. In case of a mismatch between the license
information stored in the ATConfig.ini file and the computer identification or the
current date, an error message box is displayed.
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== S5

’ [0] Use of this version of AADLInspector is allowed only with 5TOOD.
~ Please contact the support at: aadl@ellidiss.fr Tl

i ) ) Your license is invalid (error 0030).

An error number is provided to help identifying the license problem:

- 0010: this license has expired

- 0020: this license is not compatible with the encryption key
- 0030: this license is attached to another computer

- 0040: this license is linked to a Stood license

- 0050: this license is not valid for this version of the product
- 0060: this licence is invalid (empty licenseKey)

- 0070: this licence is invalid (unspecified version)

- 0080: this licence is invalid (bad licenseKey encoding)

- 0090: this licence is invalid (bad version encoding)
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3 Graphical Interface

AADL Inspector opens a single window that encompasses a main menu bar, a button
bar, a source files area, a processing tools area, a simulation area and a status bar, as
shown below:

File View Wizards Tools ?
CoeRBBR & B® V(R LB
shared_data ~ l<-hedule Table | Static Analysis| Schedulability
| Behavior_Properties | Data_Model | BassFyes Mai
- - = ain menu and button bar & s

323|PACERGE shared data_Pkg "
324 |PUBLIC test entity il
325 WITH HW: =] @bmcessor utilization factor root.my_platform.CPU The task s¢
gfﬁ SYSTEM a a base period al 75.00000

T shared data
3;3 END snaIEd_daEa: processor utilization factor with deadlir  all 0.82667

329 = processor utilization factor with pel all 0.82667
330|SYSTEM IMPLIMENTATICN sharsd data.others = {@worst case task response time ot.my_platform.CPU All task deg
23} 5U3CDM§ODJ§NT5 SYSTEM HH::RMA b . respense time rootwy_flat

2| my platform : HW: :RMA board.others; A .
333 my_process : PROCESS my_process.others: response time root.my_llat PrOGeSS]ng tools area
334 |PROPERTIES
335 Actual_Processor_Binding =» ( reference (my_platform.cpu) ) ap—|| ‘| I | |
336 END shared data.others:
337 P m ] |
338 PROCESS my_process - | | |
339 END my_process; O 2 9 5 10 15 20 25 30 35 40 45 50 55 €0 65 70 75 &0 -
340 -
341 PROCESS IMPLEMENTATION my procelss Source files area cru w

342 |SUBCOMPONENTS
343 Tl : THREAD T.il;
344 D1 : DATA D

my_process.D2

my_process.D1

345 { Concurrency Control Protocol =» PRICRITY CEILING_PFROTOCOL

346/ D2 : DATA D my_process.T2 . N

347 { Concurrency Control Protocol => PRICRITY CEILING PROTCCOL

348| T2 : THRERD T.i2; my_processTL  EEEEE—— - -

349 |CONNECTIONS ) 2

350 Cl : DATA ACCESS D1 -> T1.D1; my_process Slmulatlon a'rea'

351 €2 : DATA ACCESS D2 -> T1.D2;
352 C3 : DATA ACCESS D1 -» T2.D1; 3
353 C4 : DATA ACCESS D2 -> T2.D3r ] Status bar - ‘_l

< m -

Simulstor Stop

3.1 Main menu and button bar

The menu bar contains the following pull-down menus: File, View, Wizards, Tools and
Help. The button bar provides shortcuts for often used menu options.

File View Wizards Tools 7

CoRBBR U B eV M K
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3.1.1. File menu

The File menu controls all the actions related to the AADL files that are processed by the
tool. The tool can process several files that contribute together in defining a complete
AADL specification. The recommended way to manage multiple files is to link them
with an AADL Inspector project file (.aic). There is no particular restriction or
naming rule for the AADL files. In practice, for most of the processing tools, all the
loaded files are concatenated together before being processed by the analysis tools.
Please note that load ordering may have an impact on obtained result, especially if the
root of the AADL instance hierarchy has not been explicitly defined.

[ Mew

EJ Load Ctrl-o
i Reload

£ Load from Github

S Save Ctrl-s

@ Save As

@ Save Project As

B8 Quit Ctrl-q

- New: create a new AADL virtual file in memory.

- Load: load the contents of the specified AADL files into memory.

- Reload: cancel any non saved change for the current file.

- Load from Github: load files from remote AADL libraries (requires internet
access).

- Save: save the changes for the current file.

- Save As: save the current memory contents into a new file.

- Save All: save the changes for all the loaded files.

- Load Project: load the content of all the AADL files of the specified .aic
project into memory.

- Save Project: save the changes for the current project.
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- Save Project As: save all the opened files into a new . aic project.
- Quit: quit AADL Inspector

3.1.2. View menu

The View menu provides a menu item that constrains AADL Inspector window to
remain on the foreground of the computer screen.

Alwa}rs on top v Alwa}rs on top
¥ Close ¥ Close
¥ Close All 2 Close All
¥ Close Others ¥ Close Others

When this menu item has been called once, a tick is put against its label to indicate that
this constraint has been enabled. Another activation of this menu item will then disable
the constraint and remove the tick.

The other items displayed in this menu are:
- Close: unload the current file.
- Close All: unload all the loaded files.
- Close Others: unload all the loaded files but the current one.

3.1.3. Wizards menu

The Wizards menu provides advanced functions that can be used to perform changes on
the input AADL specification. When possible, the original source text is not modified,
and the changes are applied to an extension of the main system implementation of the
project instead.
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D Auto format

Select root

I Configure simulations

[a] Edit thread properties
@ Edit thread pricrities
[a] Edit thread placement

(L) Import UML MARTE

- Auto format: re-write the current AADL file in a normalized form. This feature
can also be used to convert AADL v1 and v2.0 files into AADL 2.1 syntax.

- Select root: provide the list of candidate system implementations and select the
one to be the root of the AADL instance hierarchy.

- Configure simulations: Specify the processor to simulate and identify the entities
that must be displayed in the graphical simulation traces.

- Edit thread properties: Open a spreadsheet to edit various real-time properties
and apply them to the current model.

- Edit thread priorities: Compute the priorities according to rate or deadline
monotonic algorithms.

- Edit thread placement. Generate processor binding according to various
placement algorithms.

- Import UML MARTE: Load a .uml file compliant in XMI syntax, apply the
MARTE to AADL model transformation and display the generated AADL
specification.
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When real-time or binding properties have been modified, the corresponding AADL
property associations are declared as contained properties of an extension of the current
root system implementation. The current root system can be selected with the Select root
wizard, otherwise it is (in decreasing priority order) the first found system
implementation containing an AI::root system property association, or the first
found system implementation containing an Actual Processor Binding property
association, or the first found system implementation that is not instantiated as a
subcomponent.

Others | Priorities | Processor Placement |

Mame | Dispatch_Protocol | Period | Compute_Execution_Time| Deadline| First_Dispatch_Time | D *

prs_PSC.bus_scheduling  periodic 10ms  2ms.2ms 10ms Oms Or
prs_P5C.data_distribution periodic 10ms 2ms.2ms 10ms Oms Ot
prs_PSC.control_task periodic 20ms  2ms.2ms 20ms Oms O
prs_P5C.radio_task periodic 20ms  2ms.2ms 20ms Oms O
prs_PSC.camera_task periodic 20ms  2ms.2ms 20ms Oms Or
prs_PSC.mesure_task periodic 400ms  4ms.4ms 400ms  Oms Or
prs_P5SC.meteo_task periodic 400ms  6ms.Gms 400ms Oms Qr

L

Apply Cancel

The extended root system is created in memory only and is located in a new : :proxy
subpackage. The newly created system contains a AI::root system property
association so that it becomes the new current root system. Note that if the user wants to
use this property to define the root system in the original file, he must not use the
property value “selected” which is reserved for the proxies.
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@ mars_pathfinder:Al_adaptation:proxy

1 |PACEAGE mars pathfinder::AT adaptation: :proxy

2 |PUBLIC

3 WITH mars pathfinder::AT adaptation;

4 |WITH &ATI:

5

& |SYSTEM sy= mars pathfinder

7 |[EXTENDS mars pathfinder::Al adaptation::sys mars pathfinder
g8 [END sy= mars pathfinder;

9

10|5¥5TEM IMPLEMENTATICH sys mars pathfinder.impl

11 EXTENDS mars pathfinder::AT adaptation::sys mars pathfinder.impl
12 |PRCEER
!iroot sysStem => "selected":
14 Priori

— -Bu= =scheduling:
15 Frigrity => 7 APFLIES TO prs P5C.data distribution:
le Frigrity => 3 APPFLIES TO prs PSC.control task:

17 Friority => 5 APPLIES TO pr= P5SC.camera task:

18 Friority => 1 APPLIES TO pr= PSC.mesure task:

19 Friority => 2 APPLIES TO prs PS5C.meteo task:

Z0END =y= mars pathfinder.impl:

21

22| END mars pathfinder::Al adaptation::proxy;

23

3.1.4. Tools menu

The Tools menu provides access to the processing tools and services that are defined in
the .ais files located in the config directory. Two tools are available with the
standard distribution: Static Analysis and Schedulability. The latter one uses the Cheddar
tool.

Static Analysis * ErRbEyla

Schedulability ¥ | 55p Aadl consistency checks
cc Aadl legality checks
pr Aadl naming checks
g53 ARIMC 653
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Metrics: provide statistics about both the instance and the declarative AADL
models.

AADL consistency checks: verify the consistency rules defined by the standard.
AADL legality checks: verify the consistency rules defined by the standard.

AADL naming checks: verify the consistency rules defined by the standard.
ARINC 653: limited set of basic verifications for partitioned systems.

Tools

Static Analysis ¥

Sl E S qee Theoritical schedulability test

sty imulation schedulability test

Theroritical schedulability test: set of feasibility tests checked by Cheddar.

Simulation schedulability test: set of tests based on the static simulation computed
by Cheddar.

3.1.5. Help menu

The ? menu provides information about AADL Inspector.

Help r
About

License info

Open tmp dir
Open config dir
Open install dir

Help: open the help files. Note that the name of the help file directory and the
application that is used to open it can be customized in the ATConfig.ini file.
By default, this application will be the default one for .pdf files on Windows
and xpdf on Linux.
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- About: display the version of the software.

- License info: provide information about the license.
- Open tmp dir: open the temporary subdirectory.

- Open config dir: open the configuration subdirectory.
- Open install dir: open the installation subdirectory.

3.1.6. Button bar

The button bar provides another entry point for a few selected menu actions.
LoB@B & & Y| & e

Effect of these actions is described in the corresponding menu section. Button association
with menu bar items is given below from left to right:

- File/New

- File/Load from Github

- File/Load Project

- File/Load

- File/Reload

- File/Save

- View/Always on top (toggle button)
- Wizards/Select root

- Wizards/Configure simulations

- Wizards/Edit thread properties, priorities and placement
- Wizards/Import UML MARTE

- File/Quit
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3.2 Source files area

The AADL files that are processed by the tool are managed with the Source files area.
The tool can process several files that contribute together in defining a complete AADL
specification. There is no particular restriction or naming rule for the AADL files. In
practice, all the loaded files are concatenated before being processed by the analysis
tools. Please note that load ordering may have an impact on obtained result, especially
while looking for the root of the AADL instance hierarchy. Displayed line numbers
reflect this ordering as it refers to the resulting file concatenation.

The source file area is composed of:

- adeployable file list

- aset of file selector tabs
- afile editing area

- aline number area

AADL

radar_system

| Deployable file list
Data_Model | Base_Types | radar_types| radar_system |
297
298 SYSTEM radar
293 |END radar;
300
301 --
302
303
304
305

File selector tabs

System implementation is composed

306
307 In
308|5Y5TEM IMPLEMENTATICN radar.simple
308 SUBCCMPCNENTS
— rind LEUICT aptenna: 3 .

311 zotor : DEVICE mater; ‘ Combined files line number area
312| monitor : DEVICE screen;

313 main : PRCCESS processing.others;

The deployable file list provides access to all the loaded files, whereas the file selector
tabs only show a limited selection of these files for a quicker access.

To load a file in the editing area a drag and drop action is possible instead of using the
File/Load menu: open the appropriate directory, select the desired file, maintain the left
mouse button down and drag the mouse until the AADL Inspector window is reached.
Pease note that this function is not available for Linux distributions.

To find all the occurrences of a word in the displayed file, select the desired word and
repeat the Ctrl-F action to navigate in the file.
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A contextual menu (right mouse button click) is associated to the current file selector tab.
It provides an easy way to close files. Effect of these menus is similar to the
corresponding ones in the File menu.

F rai
s 1

¥ Close
¥ Close All
¥ Close Others

When a file has been modified, an icon appears on the tab to indicate that the changes are
not saved.

| periedic @ sporadic

3.3  Processing tools area

The processing tools area allows for selecting the processing tool to be applied on the
AADL files loaded in the source files area, and displaying the corresponding execution
result. This area is composed of:

- aset of tool selector tabs

- one or several service control buttons
- aread-only result display area
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Schedule Table| 3tatic Analysis |Schedufabiliy | Tools selector tabs

HE “CC “LC

aadlrev2.S (c)Ellidiss Technologies 23Dec2013 Services control buttons

ARDL-2.1 =

%% THNSTANCE MODEL *** | .
____________________________________________________ | Result display area

Root System Instance: synchronous Pkg::synchronous.others

332 (svstem)..... root

237 (processor) ... root.my platform.CPT (RM)
333 (Proce23) e cvnas root.my process

345 (thread)......... Tl (PERICDIC)

350 (thread)......... T2 (PERICDIC)

355 (thread)......... T3 (PERICDIC)

- Tools selector tabs can be configured by adding or removing tool description files
(.ais files) in the config subdirectories of the installation directory

If one of the analysed file is modified, the background colour of the result display area
becomes gray to indicate that the information is potentially out of date.

When the selected analysis tool can not be executed normally for the current AADL
specification or if the AADL syntax is not correct, the corresponding error message will
appear in the Report tab. Clicking on the line number included in the error message will
highlight the corresponding line in the source files area.

While working on large AADL projects, processing actions may take a significant time
(up to a few minutes). Depending on the processing tool that is running, other user
actions may be allowed or not and the display may not be refreshed during that time.

3.3.1. Static Analysis

The static analysis tool encompasses a set of independent rules checkers that verify
various facets of the semantic correctness of the source AADL specification. Each rules
checker is implemented as a service of the static analysis tool and can be activated by
pressing on the correspondent button:
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Static Analysis

HE °CC °“LC "HC BS3

- the ME button launches the Metrics checker.

- the CC button launches the AADL Consistency rules checker.
- the LC button launches the AADL Legality rules checker.

- the NC button launches the AADL Naming rules checker.

- the 653 button launches the ARINC 653 rules checker.

More detailed explanations about the scope of each of these checkers can be found in
separate documentation documents.

When an error, warning or information message is displayed by a processing tool, the
line number of the corresponding AADL code is highlighted in both the source files area
and processing tools area. Clicking on an error line number of the processing tools area
automatically changes the source code display in order to let the erroneous line be
visible.

3.3.2. Schedulability analysis

When the schedulability tab is selected, two buttons are proposed to activate the analysis
services provided by Cheddar:

- the THE button launches the Scheduling Theoretical Tests
- the SIM button launches the Scheduling Simulation Test

Theoritical tests compute processor utilization factor and threads response time when the
corresponding conditions are met.
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Schedule Table | Static Analysis| Schedulability

THE | SIH
test entity i

= @Jrocessur utilization factor roct.my_platform.CPU We can not prove that the task o

base pericd all 300.00000

processor utilization factor with deadlir  all 0.78333

processor utilization factor with pericd  all 0.78333
= @Narst case task response time rect.my_platfoerm. CPU All task deadlines will be met : th

response time roct.my_platform.CPU.my_process. T 15.00000

response time rect.my_platform, CPULmy_process.T - 10.00000

response time rect.my_platform, CPUmy_process, T - 5.00000 R
1| i} | 3

Simulation tests provide information about the number of pre-emption and context switch
as well as threads response time. This static simulation can only be run for periodic
systems.

| Schedule Tablel Static Analysis| Schedulability |

THE |$IM
test entity resu
B @Task response time computed from simulatio  root.my_platform.CPU Mo deadline missed in the computed sched
Nurnber of preemptions root.my_platform,CPU 0
Number of context switches root.my_platform.CPU 46

Task response time computed from simulatio  root.my_platform.CPU.my_process. Tl worst = 15, best = 5 and average = 916667
Task response time computed from simulatic  root.my_platform. CPU.my_process. T2 worst = 10, best = 5 and average = 6.66667

Task response time computed from simulatio root.my_platform.CPU.my process. T3 worst = 5, best = 5 and average = 5.00000

4 | 11l | 3

More detailed explanations about the scope of each of these tests can be found in a
separate documentation document.

3.3.3. Schedule table
Cheddar can also produce a graphical representation of the timing behaviour of the real-

time system being analysed. This Schedule Table is a result of the static simulation and
may not be available on any kind of system.
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Note that it is required to click on the yellow button to launch the computation of the
Schedule Table.

Schedule Table | Static Analysis | Schedulability

CPU
my_process.T3 [ . . . . . . 1
my_process. T2 L . . L L =
my_process.T1 L . . -

My_process

Time lines are displayed for each process, thread and shared data that are active on the
currently selected processor. The time scale and meaning of each used colour are shared
with the dynamic simulator that is described below.

3.4 Simulation area

The simulation area is dedicated to controlling and displaying the output of the Marzhin
dynamic simulator. This simulator complements the static simulator that is provided by
Cheddar but is event-driven and can analyse more kinds of real-time systems. The
counter part is that the obtained time lines are not the result of mathematical computation
and are thus less dependable.

The simulation area is composed of:
- aspecific toolbar
- a simulator output area showing time lines for each process, thread and shared
data that is active on the currently selected processor.
In addition, the Configure simulations wizard can be used to set up the time scale and

filter the entities to be displayed for the simulation. This wizard can be activated from the
Wizards menu or the corresponding button in the main buttons bar.
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4 10 P T b

I
= O & O 5 10 15 20 25 30 35 40 45 50 55 60 65 70 75 80 85 ¢ .
rs_6000 I

prs_PSC.data_rw

prs_P5SC.meteo_task H I

prs_PSC.mesure_task |

m

prs_PSC.camera_task ——

B
prs_PSC.radio_task B W u B

prs_P5C.control_task

[
|
T Fal

prs_PSC.data_distribution B— R | B | B |

prs_PSC.bus_scheduling B i i i i i i i i

prs_PSC s

3.4.1. Simulator toolbar and control panel

The simulator toolbar is composed of the following buttons:

r= | start the simulator

il | pause the simulator

1 | stop the simulator

= | open the simulator control panel

The simulator control panel can be used to send commands to the simulator. It is also
possible to control the simulator from the Tools menu. Depending on the status of the
simulation, the following actions are proposed:
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i N
Simulator control pa. 2

[_'} ] @ e |@|

General prs_P5C

Speed factor:
& x5 O A0
Ok |

r~ | start the simulator

il | pause the simulator

1 | stop the simulator

4 | go to the current tick

& | refresh the simulation input file

@ | provide help about the simulation trace

When the General tab of the simulator control panel is selected, it allows for selecting
the simulation speed. Note that the speed factor can be customized in the
AADLConfig.ini file.

Simulator control ﬁ
m ogreme

G En Era| r'r'l}r_p roCess

Data port:
input |

Event port:

Ok
For each partition (process) that is bound on to the current processor, another tab is added

to the simulator control panel. This tab can be used to dynamically modify the value of
input data ports and send event ports in the process interface. Note that only integer

L9
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values are processed for data ports. These data and events can be used by the AADL
behaviour annex subclauses in threads in order to control conditional execution at
simulation runtime.

3.4.2. Simulator chronograms

Each chronogram displays the run-time information for a given processor. A separate
time-line is shown for each partition (process), each thread and each shared data
component.

The colour code that is used for the time lines can be configured in the ATConfig.ini
file and displayed by the kelp button of the Simulation control panel.

Threads:
Unknown state
State ready
— State suspended
I State running
FAowaiting resource
I Awaiting return
Get resource
Release resource

Send event
Call

Data:
Occupied
Available

The Simulator control panel can be used to start, pause and stop the simulation, to
change the simulation speed and to dynamically inject data or events through ports of the
current process.

The Configure simulations wizard opens the Filtering control panel that can be used to
display the chronogram for another processor, to reduce the number of time-lines and to
change the zoom factor (width of a time tick).

Within the Filtering control panel, the General tab can be used to define the zoom factor
and select the processor to be displayed in the simulation area. Note that all the
processors are simulated and it is possible to switch the display to show the state of
another processor at any time.
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Filtering control panel

General |5 cd u_l_software.p_cdu_display_manager | s_cdu_|_software.p_cdu_ic_r

Zoom facton

i @ 2

& x ©) 8

Processors:

@ roots_cdu_l_pn.cpm () roots_li_mfd_pn.cpm
i) root.s_ri_mfd_pn.cpm ) root.s_lo_pp_pn.cpm

! root.s_ro_pp_pn.cpm

ok || Apply || Cancel

The Filtering control panel also provides an additional tab for each process that is
running on the current processor. This tab can be used to filter the number of entities to

be displayed.

Filtering control panel

General| s_cdu_|_software.p_cdu_display_manager |s_cdu_|_softwa re.p_dujications_manager | 5_c

® Show all ©) Hide all @ Apply filter

Threads:
[t ed u_disp_cmds_5_hz_cdu_display_manager t_cdu_disp_page_5_hz_cdu_display_mar

[¥#] t_cd u_disp_page_20_hz_cdu_display_manager t_flight_page_config_5_hz_cdu_display
[#] t_rmessage_page_data_5_hz_cdu_display_manager

ok || Apply || Ccancel |

To restrict the number of threads or shared data to be displayed, select the Apply filter
radio button and unselect the components to be removed. It is required to validate the
changes by clicking on the Apply button.

Note that zoom factor, threads or data property changes also affect the Cheddar
Schedule Table.
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Note that AADL time units conversion is not taken into accounts. In order to obtain

consistent results, it is required that the same time unit for all the timing properties in the
AADL model.

3.5 Status bar and Error Report

The status bar located in the lower part of the window shows various informational or
error messages generated by AADL Inspector:

See report Details

When relevant, detailed error messages are displayed in the Report tab.

Simulator =s=topped by third party.
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